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Introduction
HP Connectivity Kit is software that facilitates the creation and distribution of HP Prime content and
establishes a classroom network of HP Prime calculators. The classroom network can then be used to
broadcast the content you create. HP Prime content includes HP apps and their data, exam-mode
configurations, formative assessments (polls), notes, and even messages to individual students. Poll
responses can be aggregated and the results displayed for discussion purposes. You can monitor the network
of HP Prime calculators and project a student display for discussion purposes.
You can use Connectivity Kit in any of the following modes:
●

Connected from a computer running Connectivity Kit to one or more HP Prime calculators, using the USB
cable included in the product package

●

Connected wirelessly to one or more HP Prime calculators using the HP Prime Wireless Kit (purchased
separately) to form an HP Wireless Classroom Network

●

Connected to one or more virtual calculators on the same computer (HP Prime Virtual Calculator is a
program that is available separately)

Whichever mode you choose, Connectivity Kit allows you to create and edit custom HP Prime content to
extend and customize your HP Prime calculator. In addition, the HP Wireless Classroom Network provides
features that enhance the HP Prime classroom experience.
Connectivity Kit provides the following capabilities:
●

Manage content and data on one or more connected calculators

●

Prepare custom HP Prime content

●

Send HP Prime content to one, some, or all connected calculators

●

Receive poll results from connected calculators and analyze the results

●

Send a message to one, some, or all connected calculators

●

Receive a message from a connected calculator

●

Activate and deactivate exam mode on connected calculators

●

Monitor and capture calculator activity

●

Project one student display live to the class for the purposes of classroom discussion

●

Update calculator software

●

Back up and restore your calculator

●

Clone one HP Prime calculator to another

For detailed information about the functionality of the HP Prime calculator, see the HP Prime Graphing
Calculator User Guide.
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Elements of the interface
When the software opens, Connectivity Kit presents three panes, as well as the familiar title, menu, and icon
bars at the top of the window.

Calculator pane
When a calculator is connected, its name appears in the calculator pane. Click the expand arrow beside a
calculator name to expand the list of content for the calculator. Double-click an object in the list to open an
editor in the work area.

Content pane
The HP Prime content that is stored on your computer appears in the content pane, in folders dedicated to
each type of content, such as exam-mode configurations and polls. As in the calculator pane, you can doubleclick a content item to open its editor in the work area.

Work area
The work area has two purposes. First, it is the area where the content editors appear. Second, it is the control
center for the HP Wireless Classroom Network, where the Monitor and Messages windows appear.

Menu bar
The menu bar contains four menus: File, Edit, Window, and Help. Each of these four menus is described in
detail in the following sections.

File menu
The File menu lists the following options:
●

Language—Display a menu to choose a language for the software

●

Exit—Close the software

Edit menu
The Edit menu lists the following options:
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●

Cut—Cut the selected data from the editor and place it in the clipboard

●

Copy—Copy the selected data from the editor and place it in the clipboard

●

Paste—Paste the clipboard contents at the cursor location

●

Preferences—Open a dialog box that lists the following options:
—

Environment

—

Working folder—The default folder for the HP Prime calculator on your computer, as shown in the
content pane

Chapter 2 Elements of the interface

—

Wireless 1 options—Choose either a channel or Automatic Selection, and then choose an SSID
name for the sub-network based on your first antenna
NOTE: Each antenna can accommodate up to 30 HP Prime calculators.

—

Wireless 2 options—Choose either a channel or Automatic Selection, and then choose an SSID
name for the sub-network based on your second antenna, if any

Window menu
The Window menu lists the following options:
●

Close—Close the active editor

●

Close All—Close all editors

●

Tile—Tile the editors

●

Cascade—Cascade open editors

●

Next—Move to the next editor

●

Previous—Move to the previous editor

●

Messages—Open or close the Messages window in the work area

●

Monitor—Open or close the Monitor window in the work area

●

Calculators—Open or close the calculator pane in the work area

●

Content—Open or close the content pane in the work area

●

Proctor Mode—Open or close the proctor mode pane in the work area

Help menu
The Help menu lists the following options:
●

HP Connectivity Kit User Guide—Open this document

●

Go to HP.com—Open the HP website

●

Update Calculator—For an HP Prime calculator connected via USB, manually update firmware to the
latest version

●

Check for Update—Check for updates for the software

●

About HP Connectivity Kit—Get information about the version of the software

Icon bar
The icon bar contains shortcuts for some of the most frequently used options in the menu bar. Move the
pointer over an icon to see its title.

Calculators icon
Click the Calculators icon to open or close the calculator pane.

Content icon
Click the Content icon to open or close the content pane.

Icon bar
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Save icon
If you are working in the calculator pane, clicking the Save icon saves the data in the active editor to the
connected calculator.
If you are working in the content pane, clicking the Save icon saves the content in the active editor to your
computer rather than to a calculator. Specifically, the content is saved to the working directory specified
under Preferences in the Edit menu.

Save All icon
You might have multiple editors open in the work area, some with HP Prime content on your computer (from
the content pane) and others with HP Prime content on your calculator (from the calculator pane). Clicking the
Save All icon saves all of your work, in its current state, on the appropriate devices. If you close the software
without saving your work, you will be prompted to Save All before closing.

New Content icon
Click the New Content icon to open a menu of new content types. You can choose one of the following:
●

Folder—Creates a new folder or sub-folder

●

Poll—Creates a new poll using the Poll Editor

●

Notes—Creates a new note using the Note Editor

●

Program—Creates a new program using the Program Editor

●

Exam Mode—Creates a new exam mode using the Exam Mode Editor

Exam Mode icon
Click the Exam Mode icon to create or open an exam mode configuration.

Poll icon
Click the Poll icon to create or open a poll.

Proctor Mode icon
Click the Proctor Mode icon to open or close the proctor mode pane.

Monitor icon
Click the Monitor icon to open the Monitor window in the work area. This is a shortcut for opening the Monitor
window via the Window menu.

Messages icon
Click the Messages icon to open the Messages window in the work area. This is a shortcut for opening the
Messages window via the Window menu.

Classroom network ID
You connect the computer running Connectivity Kit to multiple calculators by either connecting the USB cable
included with each HP Prime calculator to a USB port on the computer or to a USB hub or using wireless
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adapters (purchased separately). When a number of calculators are connected wirelessly in a classroom
setting, give your network a unique ID to distinguish it from other wireless networks in the vicinity.
1.

In the Connectivity Kit menu bar, click Edit and select Preferences. The Preferences dialog box opens.

2.

For each antenna connected to Connectivity Kit (up to a maximum of 2), there is a separate area:
Wireless-1 and Wireless-2. In the SSID box for each antenna, enter a unique classroom ID. For example,
if you have two antennas connected, you could enter Miss May 1 as the SSID for Wireless-1 and
Miss May 2 as the SSID for Wireless-2.

3.

Click OK.

Classroom network ID
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Getting started

Naming a calculator
Before installing Connectivity Kit, make sure that the calculators you plan to use with Connectivity Kit have
been named. This enables you to distinguish one connected calculator from another in the Connectivity Kit
window.
To name a calculator, follow the steps below.
1.

On the calculator, press

. The Home Settings screen opens.

2.

Tap

3.

Tap the Calculator Name box.

4.

Use the calculator keys to enter the calculator name in the box.

5.

Tap

to go to the second page of the screen.

.

Installing Connectivity Kit
Whether you plan to use Connectivity Kit with a single HP Prime calculator connected via the USB cable or
with an entire class connected wirelessly, you must first install Connectivity Kit. On the included product CD,
locate the file HP_Connectivity_Kit.exe, and double-click it. Or, on the HP website, locate the file
HP_Connectivity_Kit.exe, download it to your computer, and then double-click it. Follow the onscreen instructions to complete the installation.

Starting Connectivity Kit
If you installed the Connectivity Kit icon on your desktop, locate and double-click the icon to start Connectivity
Kit.
Otherwise, do the following:
1.

On the computer, open the Start menu.

2.

Locate and open the HP Calculators folder.

3.

Click HP Connectivity Kit.

Connecting a calculator via USB
To connect an HP Prime calculator to the computer running Connectivity Kit, use the USB cable included in the
product package, and follow the steps below. It is best if your computer has an active Internet connection.
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1.

Start Connectivity Kit, if you have not done so already (see Starting Connectivity Kit on page 6.

2.

The cable included in the HP Prime package has two connectors. Connect the micro-USB end to the
micro-USB port on the top of the HP Prime calculator and then connect the standard USB plug to a USB
port on your computer.
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3.

Turn on the HP Prime calculator. The HP Prime calculator will appear by name in the calculator pane; if it
does not, try using a different USB port on your computer.

4.

If the software of your HP Prime calculator cannot connect to Connectivity Kit, you will be prompted to
update the software. Accept the software update, and the calculator will first update and then connect.

Connecting a calculator wirelessly
To connect an HP Prime calculator to the computer running Connectivity Kit, by using the HP Prime Wireless
Kit (purchased separately), follow these steps:
1.

Connect the antenna included with the HP Prime Wireless Kit to a USB port on your computer.

2.

Start Connectivity Kit, if you have not done so already (see Starting Connectivity Kit on page 6).

3.

Connect the wireless module to the micro-USB port on the top of the calculator.

4.

Turn on the HP Prime calculator.

5.

Tap the date/time in the upper right corner of the HP Prime display. A window opens, displaying the
wireless status icon.

6.

Tap this icon to connect to the classroom network. A menu opens. Click the list arrow to display the
available networks, and then click the name of your network.

Connecting to the virtual calculator
If you start HP Prime Virtual Calculator on the same computer that is running Connectivity Kit, the virtual
calculator connects automatically to Connectivity Kit.
Whichever method you use to connect, the HP Prime calculator will appear by name in the calculator pane,
with an expansion arrow that you can click to see the contents of the HP Prime calculator.

Connecting a calculator wirelessly
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Establishing an HP Wireless Classroom
Network
This section describes how to establish an HP Wireless Classroom Network and provides details for
troubleshooting wireless connections. If you plan to use Connectivity Kit with the USB cable only, you can skip
this section.

About the wireless network
Connectivity Kit establishes your wireless classroom network using the following items:
●

An antenna, provided in the HP Prime Wireless Kit, for connecting up to 30 HP Prime calculators. You can
use up to three antennas in a single classroom network.

●

The wireless module for the HP Prime calculator.

●

An SSID name to identify each antenna in the network to an HP Prime calculator.

●

A channel for each antenna to send and receive signals.

Connectivity Kit establishes the wireless network via one to three antennas to identify itself to the available
HP Prime calculators. Each antenna in the Connectivity Kit network uses a default SSID name: HP_Class_1,
HP_Class_2, and HP_Class_3. You can change these names to something more unique to make sure that two
nearby networks do not have the same name and that your students can identify the correct antenna if more
than one is available (see Changing the SSID on page 9). By default, Connectivity Kit chooses a default
channel for each antenna to minimize interference. You can manually change the channel if it encounters
interference from another antenna or other networks in the area.

Setting up a network with multiple antennas
1.

Connect up to three antennas to USB ports on your computer.

2.

Start HP Connectivity Kit.

3.

On the menu bar, click Edit and then select Preferences. The Preferences dialog box opens.

4.

If your class is using the HP Prime app on a tablet or other device, select Enable Network under IP
Networking.

5.

Verify that all devices running the HP Prime app and the computer running HP Connectivity Kit are on the
same subnet, and then verify that UDP broadcast packets are not blocked by the network administrator.
NOTE: If you do not complete this step, the devices might not be able to discover HP Connectivity Kit
and join the classroom network.

6.

There are two areas in the dialog box for connections to HP Prime calculators: Wireless-1 and
Wireless-2. For each connected antenna, the radio frequency (RF) version for that antenna is identified
by number; open antenna slots are identified by the text No adapter found. Enter a unique SSID for each
connected antenna.
For example, under Wireless-1, enter My Class 1. Under Wireless-2, enter My Class 2.
TIP:
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Optionally, you can manually select channels for each antenna.
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7.

Click OK to close the Preferences dialog box.

8.

Connect the included wireless module to an HP Prime calculator, and then connect the calculator to the
first antenna using the following procedure:

9.

a.

Turn on the HP Prime calculator.

b.

Tap the top-right corner of the calculator display to open the Quick Settings menu.

c.

Tap the wireless icon to open Page 4 of Home Settings.

d.

Tap the Network box, and then tap the unique SSID of Wireless-1.

Repeat step 6 for up to 29 more HP Prime calculators.

10. If your class has more than 30 students, repeat step 6, but connect to the second antenna by selecting
the unique SSID of Wireless-2 during step d. Repeat this step up to 29 times to connect a total of 60 HP
Prime calculators.

Troubleshooting a wireless connection
If you follow the steps for a wireless connection (see Connecting a calculator wirelessly on page 7) and do not
see the HP Prime calculator appear by name in the calculator pane, follow these steps:
1.

Confirm that the calculator is on.

2.

Verify that the wireless USB adapter is properly plugged in to the calculator.

3.

On the HP Prime calculator, go to the fourth page of the Home Settings screen, or tap the top-right
corner of the calculator display to open the Quick Settings menu and then tap the wireless icon. Verify
that the calculator is connected to an antenna on the correct wireless network. The network name in the
top box of page 4 of the Home Settings screen must match the unique SSID for the antenna in
Connectivity Kit. Make sure that no more than 30 HP Prime calculators are connected to the same
antenna. Tap the Network box (at the top of the display) to open a menu and select the correct antenna
and network.

Changing the SSID
To confirm, edit, or change the SSID for each antenna of the classroom network on Connectivity Kit, follow
these steps:
1.

On the Connectivity Kit menu bar, click Edit and select Preferences.

2.

In the Preferences dialog box, locate the first antenna in the Wireless-1 area. Find the SSID box near the
bottom of the area. The name in that box is the current name for that antenna in your wireless
classroom network.

3.

To change the name, click the SSID box, delete the current name, and enter your own unique name for
the antenna.

4.

If you have multiple antennas, repeat steps 2 through 3 for each of the other antennas.

5.

Tap OK when you are done.

Selecting a channel manually
By default, Connectivity Kit selects one of 13 channels automatically for each antenna on its wireless
classroom network. If you encounter interference with a nearby network, you can change the channel used
for each antenna on your wireless network to eliminate that interference. Use the following procedure.

Troubleshooting a wireless connection

9

10

1.

Confirm that you have given each antenna in your wireless network a unique ID (see Changing the SSID
on page 9).

2.

If each antenna ID is unique and you are still seeing calculators that are not in your network, try
selecting a different channel for your wireless network. Return to the Preferences dialog box and find
the Wireless-1 area. Clear the check box next to Automatic Selection, and then select a different
channel using the up and down arrows to the right of the Channel box. Tap OK to exit the Preferences
dialog box.

3.

You might need to repeat Step 2 until you find a channel for each antenna (including Wireless-2) that
does not interfere with nearby networks.

4.

You might have to restart Connectivity Kit.

Chapter 4 Establishing an HP Wireless Classroom Network
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Calculator pane

Introduction
Once you have connected an HP Prime calculator to Connectivity Kit, you can customize and extend your HP
Prime calculator with data, programs, notes, apps, and so on by using the calculator pane.
This pane can be undocked from its default location and moved anywhere on your computer screen. You can
also resize the pane to the dimensions that suit your needs. Finally, you can hide and reopen the calculator
pane. When you reopen the pane, its size and location are the same as they were before the pane was hidden.
From the calculator pane in Connectivity Kit, you can do the following:
●

View and edit Home settings

●

Back up, restore, and clone your HP Prime calculator

●

View the contents of the calculator

●

Drag and drop HP Prime content from the calculator pane to the content pane

●

Drag and drop HP Prime content from your computer to a calculator in the calculator pane

●

Open editors in the work area

Calculator context-sensitive menu
After the HP Prime calculator appears by name in the calculator pane, right-click the name of the HP Prime
calculator to open its context-sensitive menu. The following options are available:
●

Preferences—Edit many of the settings on the first two pages of the calculator’s Home settings

●

Rename—Change the name of the calculator (from Page 2 of the Home settings)

●

Get screen capture—Copy or save the current display of the calculator

●

Backup—Back up the calculator to your computer

●

Clone from here—Clone this calculator to another calculator

●

Restore—Restore the calculator from a backup file you saved to your computer

●

Properties—See the version date and number of the calculator software

●

Refresh—Refresh the display of this calculator to Connectivity Kit

Using the calculator pane
Click the expand arrow to the left of the name of an HP Prime calculator to display a list of content types on
the calculator. The list includes the following:
●

Application Library

●

CAS Vars

●

Complex (vars)

●

Exam Configurations
Introduction
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●

List

●

Matrices

●

Notes

●

Programs

●

Real (vars)

●

Variables

The content types with expand arrows (for example, Application Library) are categories of content. Click an
expand arrow to see the list of content in that category. Click a content object to select it. Right-click a content
object to open a context-sensitive menu. The menu varies from object to object, but the usual options include
the following:
●

Open—Opens the object and its editor.

●

Send to class—Sends the object to all calculators currently in the calculator pane. If one or more
calculators are selected in the Monitor window, the content is sent to the selected calculators only.

●

Delete—Deletes the object or clears the contents of a built-in object.

If you have HP Prime content on your desktop, you can drag it to a calculator in the calculator pane to copy it
to that calculator; if the file has multiple types of HP Prime content (apps, programs, notes, and so on), the
different content objects will be sorted and saved to the appropriate locations. You can drag HP Prime content
from your desktop to the content pane. In the content pane, you can right-click content objects and select
Send to class. You can also drag content from the content pane to a calculator in the calculator pane to copy
the item to that calculator only.
You can drag a calculator name from the calculator pane to your desktop. A folder with that name will appear
on your desktop, containing all of that calculator’s settings and data.

The editors
Each HP Prime content type has its own dedicated editor. See The editors and the work area on page 14 for
more details on using the editors to create and edit the various HP Prime content types.
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Content pane

Introduction
The content pane is where you keep the HP Prime content on your computer. The content pane displays the
contents of the working folder, as listed in Preferences in the Edit menu. Within this folder are all the HP
Prime content files you have saved to your computer.
This pane can be undocked from its default location and moved anywhere on your computer screen. You can
also resize the pane to the dimensions that suit your needs. Finally, you can hide and reopen the calculator
pane. When you reopen the pane, its size and location are the same as they were before the pane was hidden.
As in the calculator pane, you can perform the following tasks in the content pane:
●

View the HP Prime content that is stored on your computer

●

Drag and drop HP Prime content from your computer to Connectivity Kit

●

Drag and drop HP Prime content from the content pane to a calculator in the calculator pane

●

Drag and drop HP Prime content to the Monitor window to distribute it to the class

●

Right-click a content object and select Send to class to distribute it to the class

●

Open editors in the work area for HP Prime content

Unlike the calculator pane, the content pane allows you to perform the following additional tasks:
●

Create and edit class polls

●

View and project poll results

●

Broadcast a poll

●

Boadcast poll results

When broadcasting polls, poll results, or HP Prime content, you can choose to broadcast to the entire class, a
single group within the class, or a single HP Prime calculator.
It is important to keep in mind that the content pane contains the HP Prime data and content that is stored on
your computer, while the calculator pane shows many of the same types of content stored on an HP Prime
calculator. In both panes, when you double-click an object, the object will open in its own editor in the work
area. See The editors and the work area on page 14 for more details on each editor.

Introduction
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The editors and the work area

Introduction
The work area contains all open editors for HP Prime content. It also contains the Monitor and Messages
windows when you have those windows open.

The editors
Each HP Prime content type (note, program, app, and so on) has its own special editor, designed to make it
easy for you to create and edit custom content to customize and extend your HP Prime calculator. The
following sections describe each editor in turn.
NOTE: The following sections assume that you are opening the editors from the calculator pane. However,
the behavior is the same if you open an editor from the content pane. The only difference is where the HP
Prime content is stored.
When you save from an editor in the calculator pane, the content is stored on an HP Prime graphing calculator
or a virtual calculator. When you save from an editor that you opened from the content pane, the content is
stored to your computer in the default working folders in the content pane.

Renaming a calculator
You can use Connectivity Kit to give your HP Prime calculator a name or change its name.
1.

In the calculator pane, locate the name of the calculator you want to rename.

2.

Right-click the calculator name, and select Rename.

3.

Type the new calculator name, and press the Enter key.

To confirm that the connected calculator has been renamed, press

, and tap

to move to the second page of the Home Settings screen. You will see the new calculator
name in the Calculator Name box.

Editing Home settings
You can use Connectivity Kit to edit Home settings on your HP Prime calculator. For detailed information
about the Home settings in the HP Prime calculator, see the HP Prime Graphing Calculator User Guide.
To edit the Home settings on your HP Prime calculator:
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1.

In the calculator pane, locate the name of the calculator whose settings you want to edit.

2.

Right-click the calculator name, and select Preferences. The Preferences dialog box opens.

3.

Edit the settings.

4.

Click Save.

Chapter 7 The editors and the work area

To confirm that the settings have been edited in the connected calculator, press

to open the

Home Settings screen. You will see the edited settings in the pages of the screen.

Backing up data and settings
You can use Connectivity Kit to back up the data and settings of a connected calculator:
1.

In the calculator pane, locate the name of the calculator whose data and settings you want to back up.
Click the expand arrow next to the calculator’s name.

2.

Right-click the calculator name, and select Backup. A Backup dialog box opens.

3.

Navigate to the location in which you want to save the backup zip file.

4.

Give the backup zip file an appropriate file name.

5.

Click Save.

Restoring data and settings
You can use Connectivity Kit to restore the data and settings of your HP Prime calculator from a backup zip file
saved to your computer.
1.

In the calculator pane, locate the name of the calculator that you want to restore. Click the expand arrow
next to the calculator’s name.

2.

Right-click the calculator name, and select Restore. A Restore dialog box opens.

3.

Navigate to the location in which you saved the backup zip file you now want to restore.

4.

Click the backup zip file.

5.

Click Open.

After you click Open, the name of the calculator whose data and settings you are restoring will disappear
momentarily from the list of calculator names in the calculator pane. When the data and settings have been
successfully restored, the name of the calculator will reappear at the end of the list of calculator names.

Cloning a calculator
You can use Connectivity Kit to clone data and settings of one HP Prime calculator and apply them to another
HP Prime calculator:
1.

In the calculator pane, locate the name of the calculator whose data and settings you want to clone.
Click the expand arrow next to the names of these calculators.

2.

Right-click the calculator name, and select Clone from here.

3.

Locate the name of the calculator to which you want to apply the cloned data and settings.

4.

Right-click the calculator name, and select Clone to here.

After you select Clone to here, the name of the calculator to which you are applying the cloned data and
settings will disappear momentarily from the list of calculator names in the calculator pane. When the data
and settings have been successfully cloned, the name of the calculator will re-appear at the end of the list of
calculator names.

Backing up data and settings
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Editing real variables
You can use Connectivity Kit to edit real variables (A–Z and θ) on your HP Prime calculator.
The real variable editor in Connectivity Kit has two columns. The left column contains the variable names, and
the right column contains the values assigned to the variables. By default, each complex variable is assigned
a value of 0. To edit real variables:
1.

In the calculator pane, locate the name of the calculator whose real variables you want to edit.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, double-click Real. The Real variable editor opens in the editor pane.

4.

In the editor, click the cell to the right of the name of the variable you want to edit.

5.

Use the computer keyboard to enter the desired value for the variable in the cell, and press Enter. The
highlight cursor moves to the next variable in the editor.

6.

Repeat steps 4 through 5 for any other real variables you want to edit.

7.

Click the Save icon in the icon bar.

To confirm that the new value of a variable has been saved to your connected HP Prime calculator, go to the
Prime Home view, press the key combination that corresponds to the variable you edited, and press
. You will see the new value of the variable in the history. For example, if you set the real variable
B to be 32, when you press

, you will see 32 in the history.

Editing complex variables
You can use Connectivity Kit to edit the complex variables Z1–Z9 and Z0.
The complex variable editor in Connectivity Kit has two columns. The left column contains the variable names.
The right column contains the values assigned to the variables. If a variable has no value assigned to it, a 0
appears in the right column beside that variable name.
Complex variables can be entered in the editor as either (x,y) or x+yi (where x is the real part of the complex
number, and y is the imaginary part).
To edit complex variables on your HP Prime calculator:
1.

In the calculator pane, locate the name of the calculator whose complex variables you want to edit.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

Click List to see L0–L9. Double-click one of these lists to open its List Editor.

4.

In the editor, click the first cell to edit it.

5.

Use the computer keyboard to enter the desired value for the variable in the cell, and press Enter. The
highlight cursor moves to the next variable in the editor.

6.

Repeat steps 4 through 5 for any other complex variables you want to edit.

7.

Click the Save icon in the icon bar.

To confirm that a variable has been edited in the connected calculator, go to the Home view, press the key
combination that corresponds to the variable you edited, and press
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. You will see the edited

value of the variable in the history. For example, if you set complex variable Z0 to be 5+3*i, when you press
, you will see 5+3*i in the history.

Editing list variables
You can use Connectivity Kit to edit the list variables L1–L9 and L0.
To edit a list variable:
1.

In the calculator pane, locate the name of the calculator whose list variables you want to edit.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, double-click List. The list variable editor opens in the editor pane.

4.

In the editor, click the cell below the name of the variable you want to edit.

5.

Use the computer keyboard to enter the first element of the list into the cell, and press Enter. The
highlight cursor moves to the next element in the list.

6.

Use the computer keyboard to enter the second element of the list into the cell, and press Enter.

7.

Repeat steps 5 through 6 for the other elements in the list, and repeat steps 4 through 6 for any other
list variable you want to edit.

8.

Click the Save icon in the icon bar.

To confirm that a list has been saved to your HP Prime calculator, go to the Home view, press the key
combination that corresponds to the list you edited and press

. You will see the edited value of

the variable in the history. For example, if you set list variable L1 to be {1,2,3,4,5}, when you press
, you will see {1, 2, 3, 4, 5} in the history.

Editing matrix variables
You can use Connectivity Kit to edit the matrix variables M1–M9 and M0.
You can edit only one matrix variable at a time in the matrix variable editor. The number of rows and columns
in the editor depends on the number of rows and columns in the matrix variable you are editing. When you
edit data in the final column or row, the editor creates a new column or row in case you need it.
To edit a matrix variable:
1.

In the calculator pane, locate the name of the calculator whose matrix variable you want to edit.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, click the expand arrow beside Matrices to expand a list of the names of matrix
variables.

4.

In the second expanded list, double-click the name of the matrix variable you want to edit. A matrix
variable editor opens in the editor pane.

5.

Click the top left cell.

6.

Use the computer keyboard to enter the desired value into the cell, and press Enter.

Editing list variables
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7.

Move to another cell in the editor by either clicking the cell or pressing the arrow keys on the computer
keyboard.

8.

Use the computer keyboard to enter the desired value into this cell, and press Enter.

9.

Repeat steps 7 through 8 for the other elements in the matrix.

10. Click the Save icon in the icon bar.
To confirm that a matrix has been saved to your HP Prime calculator, go to the Home view, press the key
combination that corresponds to the variable you edited and press

. You will see the edited value

of the variable in the history. For example, if you set matrix variable M1 to be [[1,2],[3,4]], when you press
, you will see [[1, 2], [3, 4]].

Editing and creating programs
You can use Connectivity Kit to edit and create programs for your HP Prime calculator. For detailed
information about programming, see the programming chapter of the HP Prime Graphing Calculator User
Guide.
To edit a user program on your HP Prime calculator:
1.

In the calculator pane, locate the name of the calculator whose user program you want to edit.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, click the expand arrow beside Programs to expand a list of names of user
programs. (If there is no expand arrow beside Programs, the calculator has no user programs.)

4.

In the second expanded list, double-click the name of the user program you want to edit. A program
editor opens in the editor pane.

5.

Use the computer keyboard to edit the program in the editor.

6.

Click the Save icon in the icon bar.

To confirm that the program has been saved to your HP Prime calculator, press

to open

the Program Catalog. You will see the program name in the catalog. Tap the name, and you will see the edited
and saved program.
To create a user program:
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1.

In the calculator pane, locate the name of the calculator in which you want to create the new user
program.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, right-click Programs and select New.

4.

An edit box appears. Enter a name for your new program and press the Enter key. The program editor
opens with your new program.

5.

Use the computer keyboard to enter the program in the editor.

6.

Click the Save icon in the icon bar.
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To confirm that the program has been created on your HP Prime calculator, press

to open

the Program Catalog. You will see the program name in the catalog. Tap the name, and you will see the edited
and saved program.

Editing and creating notes
You can use Connectivity Kit to edit and create notes for your HP Prime calculator.
To edit a note on your HP Prime calculator:
1.

In the calculator pane, locate the name of the calculator whose note you want to edit.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, click the expand arrow beside Notes to expand a list of names of notes. (If there is
no expand arrow beside Notes, the calculator has no notes.)

4.

In the second expanded list, double-click the name of the note you want to edit. A note editor opens in
the editor pane.

5.

Use the computer keyboard to edit the note in the editor.

6.

Click the Save icon in the icon bar.

To confirm that the edited note has been saved to your HP Prime calculator, press

to open

the Note Catalog. You will see the note name in the catalog. Tap the name and you will see the edited note.
To create a note and save it to your HP Prime calculator, follow these steps:
1.

In the calculator pane, locate the name of the calculator in which you want to create the note.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, right-click Notes and select New.

4.

An edit box appears. Enter a name for your new note and press

. The note editor opens with

your new note.
5.

Use the computer keyboard to add the note text in the editor.

6.

Click the Save icon in the icon bar.

To confirm that the note has been created on your HP Prime calculator, press

to open the

Note Catalog. You will see the name of the note in the catalog. Tap the note name to see the note text.

Editing app content
You can use Connectivity Kit to edit the data in any HP app and then save it to your HP Prime calculator. In this
manner, you can create examples and send them to your HP Prime calculator, and then connect your HP
Prime calculator to another HP Prime calculator and send that app along.
The data in an HP app is stored in app variables and contained in a file with the hpapp extension. Each app
also has its own program and its own note, contained in files with the respective extensions hpappprgm and
hpappnote. These files can be edited through the main App Editor. Each app editor in Connectivity Kit has tabs
for the different types of app content that you can edit. All app editors have Modes, Program, Info (Note),

Editing and creating notes
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Files, and Variables tabs. App editors might also have some or all of the following tabs: Results, Symbolic,
Plot, and Numeric.
After you make changes to an app, the title in the affected editor shows an asterisk after the app name to
remind you to save your changes. Similarly, the app name in the Application Library in Connectivity Kit shows
an asterisk. Click the Save or Save All icon to save your work before continuing.
For example, the Function app editor has a Symbolic tab with the variables F1(X), F2(X), and so on. The Plot
tab has Xmin, Xmax, and the other variables associated with the Plot view. You edit these variables to set up
the app with the functions you want and the Plot view settings, and so on. Then you save the whole app to
your HP Prime calculator.
In addition to an app editor, each app has folders for its own files and variables. These become visible when
you click the expand arrow for the app. The Variables folder contains any user-defined variables associated
with an app. Right-click the Variables folder to open its context-sensitive menu. The options include the
following:
●

Add—Adds a new variable

●

Clear—Deletes all user app variables

Right-click the Files folder to open its context-sensitive menu. The options include the following:
●

Add file—Adds a user file to the app
NOTE: HP does not recommend adding large files.

●

Add icon—Adds an image to identify the app in the Application Library
If you add a PNG file named icon.png to the Files folder, that file is used as the icon for the app in the
Application Library. Using the Add icon option simplifies this process. The Add file option opens a
browser where you can select an image file from your computer memory.
NOTE: HP does not recommend adding large files or a large number of files.

For detailed information about the app objects for each app, see the HP Prime Graphing Calculator User Guide.
To edit app content on your HP Prime calculator:
1.

In the calculator pane, locate the name of the calculator whose app content you want to edit.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, click the expand arrow beside Application Library to expand the list of app icons.

4.

In the second expanded list, double-click the icon of the app whose content you want to edit. The app
editor opens in the editor pane.

5.

In the app editor, click the tab that contains the app object you want to edit.

6.

Edit the object as required.

7.

If you want to edit another app object, click the tab that contains it.

8.

Edit the object as required.

9.

Repeat steps 7 through 8 for any other app objects you want to edit.

10. Click the Save icon in the icon bar.
To confirm that the HP app has been saved to your HP Prime calculator, press

, tap the icon of the app

whose content you edited. Go to each view of the app to see the content you edited. If you edited the Info
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note, press

to see it; if you edited the app program, press

to open the

Program Catalog, and then open the app program to see your changes.

Exam-mode configurations
The functions and features of the HP Prime calculator can be temporarily restricted for examination
purposes. The process of restricting one or more HP Prime calculators for an examination is referred to as
exam-mode configuration.
Exam-mode configuration can be done on one HP Prime calculator and then started on that HP Prime
calculator or sent to another HP Prime calculator. Or you can use Connectivity Kit to define, start, and stop an
exam-mode configuration.
Using Connectivity Kit, you can define one or more exam-mode configurations, start a configuration on an
connected HP Prime calculator, start the same exam-mode configuration on all wirelessly connected HP
Prime calculators, and stop an exam-mode configuration on one or more connected HP Prime calculators.
The exam-mode configuration editor in Connectivity Kit lets you set the following parameters:
●

Whether the exam-mode configuration file is read-only.

●

The time after which the exam mode will time out.

●

The default angle format (or none).

●

A password to deactivate the exam mode.

●

Whether the calculator memory is kept, erased, or hidden when the exam mode is activated. Select Keep
and restore to keep the calculator memory when the exam mode is activated and then restore it to the
same state after exam mode is deactivated.

●

Whether the three LED lights on the calculator blink while it is in exam mode.

●

Whether a security code is required to start exam mode. The proctor creates the code and gives it to the
students at the start of the exam. The code determines how the lights blink in exam mode.

After setting these options as you prefer, you then select the functions and features you want to disable while
the calculator is in exam mode. Click Start to activate exam mode on all connected HP Prime calculators. Click
Stop to deactivate exam mode on all connected HP Prime calculators. When the exam-mode configuration is
open and ready to start, click Proctor Mode to open the proctor mode pane. Also, you can select your new
exam-mode configuration from the proctor mode pane. For detailed information about exam-mode
configurations, see the HP Prime Graphing Calculator User Guide.
To edit an exam-mode configuration on your HP Prime calculator:
1.

In the calculator pane, locate the name of the calculator whose exam-mode configuration you want to
edit.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, click the expand arrow beside Exam Configurations to expand the list of names of
exam-mode configurations.

4.

In the second expanded list, double-click the name of the configuration you want to edit. The exammode configuration editor opens in the editor pane.

5.

Select the features you want to disable during the examination. Click an expand arrow to expand the list
of features that you can disable.

6.

Click the Save icon in the icon bar.

Exam-mode configurations
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To confirm that the exam-mode configuration has been edited in the connected calculator, press
, and tap

twice to move to the third page of the Home Settings screen. In the

Configuration list, select the name of the configuration. You will see the edited configuration settings on this
page, and if you tap
you will see the functions you selected to disable.
To create a new exam-mode configuration for your HP Prime calculator:
1.

In the calculator pane, locate the name of the calculator for which you want to create a new exam-mode
configuration.

2.

Click the expand arrow beside the calculator name to expand the list of content for the calculator.

3.

In the expanded list, click the expand arrow beside Exam Configurations to expand the list of names of
exam-mode configurations.

4.

In the second expanded list, right-click Custom Mode, and select Copy.

5.

A new exam mode named Custom Mode Copy appears. Right-click Custom Mode Copy, select Rename,
and then enter a name for your new exam-mode configuration.

6.

Double-click the name of the new configuration. An exam-mode configuration editor opens in the editor
pane.

7.

Select the features you want to disable during the examination. Click an expand arrow to expand the list
of features that you can disable.

8.

Click the Save icon in the icon bar.

To confirm that the exam-mode configuration has been created on your HP Prime calculator, press
, and tap

twice to move to the third page of the Home Settings screen. In the

Configuration list, select the name of the exam-mode configuration. You will see the edited configuration
settings on this page, and if you tap
you will see the functions you selected to disable.

Deleting, resetting, and clearing HP Prime content objects
HP Prime content objects have rules regarding deletion. For example, an HP app that you have saved with a
new name can be deleted from the App Library, but a native HP app can only be reset to factory defaults and
cannot be deleted entirely. Similarly, the Home variables can be cleared of their current contents but cannot
be deleted entirely. Conversely, notes and programs can be deleted from memory. There must always be at
least one exam-mode configuration. This configuration can be reset, and any additional exam-mode
configurations can be deleted. To delete, reset, or clear an HP Prime content object, right-click it and select
the appropriate option (clear, reset, or delete) from the menu. Pressing the Delete (or Backspace) key on your
computer keyboard might delete HP Prime content such as polls, poll results, notes, and programs.
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Updating the HP Prime software
You can use Connectivity Kit to update the software of an HP Prime calculator. Updating software will ensure
that the calculator has any new features included in the latest version.
To update calculator software, the calculator must be connected with a cable to the computer on which
Connectivity Kit is running. Calculator software cannot be updated if the calculator is connected to the
computer via a wireless network.
Updating calculator software does not result in loss of current data and settings of the calculator, but it is
recommended that you save a backup of the data and settings just in case. Refer to Backing up data and
settings on page 15 for details of how to do this.

Downloading new software
You must check periodically to see if updated software has been released. To check for an update, your
computer must have an active Internet connection. To check to see if there is an update to your existing
software, follow these steps:
1.

Connect the HP Prime calculator to your computer using the included USB charging cable.

2.

Start HP Connectivity Kit.

3.

In the Calculators pane, right-click the name of the HP Prime calculator you want to update and select
Properties.

4.

Make a note of the version number and then click the OK button.

5.

Click the Help menu and select Check for update.

6.

The Check for update pop-up box appears. You will see various messages as Connectivity Kit looks for an
update. If it finds one, it will ask if you want to download it.

7.

If the version number is later than the version number you noted in step 5, click the Download button;
otherwise click the Cancel button.

Updating the software
To update the HP Prime software, follow these steps:
1.

Connect the HP Prime calculator to your computer using the included USB charging cable.

2.

Start HP Connectivity Kit.

3.

Click the Calculators pane.

4.

In the Calculators pane, right-click the name of the HP Prime calculator you want to update and select
Update firmware.

5.

The Update firmware pop-up box will appear in the calculator tab and the calculator display will change
to Recovery Mode. You will see various messages as the software files are updated on your HP Prime
calculator. After the software has been successfully updated, the HP Prime calculator will reset itself and
you will be able to use it and access any new features.

Downloading new software
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Troubleshooting a software update
If for any reason the software does not update successfully, try the following steps:
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1.

Reset the HP Prime calculator by inserting the end of a paper clip into the reset hole in the back of the
calculator.

2.

Connect the USB cable to a different USB port on your computer.

3.

Repeat steps 2 through 5 in Updating the software on page 23.
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HP Wireless Classroom Network
HP Connectivity Kit can be used with up to 30 HP Prime calculators and the HP Prime Wireless Kit (purchased
separately) to create the HP Wireless Classroom Network. The HP Wireless Classroom Network allows a
teacher to use Connectivity Kit as follows:
●

Monitor and capture the students’ HP Prime displays

●

Project one student’s HP Prime display for discussion purposes

●

Broadcast HP Prime content to the class

●

Start and stop exam-mode configurations for the entire class

●

Display poll results for discussion purposes and send poll results back to the class

In addition, students can use the HP Prime message center to respond to a poll, send the teacher a message,
or raise a quick flag for help. All of these features are explained in the following sections.
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10 Preparing class content
From the content pane in Connectivity Kit, you can prepare HP Prime content for classroom distribution,
including the following:
●

Home variables (lists, matrices, and so on)

●

HP apps with their data

●

Notes and programs

●

Exam-mode configurations

●

Formative assessments (polls and quizzes)

●

Poll or quiz results

The content created here is saved to your computer in the working folder you specify in the Preferences
dialog box in the Edit menu.
You edit HP Prime content in the content pane exactly the same way as in the calculator pane (see Calculator
pane on page 11). The focus in these sections is on creating exam-mode configurations and polls for
distribution to a class.

Preparing exam-mode configurations
The functions and features of the HP Prime calculator can be temporarily restricted for examination
purposes. The process of restricting one or more HP Prime calculators for an examination is referred to as
exam-mode configuration.
Creating and editing exam-mode configurations can be done in the content pane, and the configuration can
be saved to your computer. You can select a configuration and then start or stop the configuration for the
whole class.
Click the Exam Mode icon in the icon bar to open or create an exam mode configuration. Or, click the New
Content icon and then select Exam Mode.
The exam-mode configuration editor in the content pane of Connectivity Kit lets you set the following:
●

A name for your configuration.

●

Whether the exam-mode configuration file is read-only.

●

The time after which the exam mode will time out.

●

The default angle format (or none).

●

A password to deactivate the exam mode.

●

Whether the calculator memory is kept, erased, or hidden when the exam mode is activated. Select Keep
and restore to keep the calculator memory when the exam mode is activated and then restore it to the
same state after exam mode is deactivated.

●

Whether the three LED lights on the calculator blink while it is in exam mode.

After setting these options as you prefer, you then select the functions and features you want to disable while
the calculator is in exam mode. You can disable any or all of the following:
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●

HP apps

●

Saved apps

●

Physics constants

●

The Help system

●

Units

●

Matrices

●

Complex number operations

●

The CAS

●

Connectivity (I/O)

●

Notes and Programs

●

New Notes and Programs

●

The Math menu

For the HP apps, you can disable all of them or just a selection, as you see fit. Select the System Apps check
box to disable all HP apps or click the expand arrow beside it to expand the list of HP apps. Select the app you
want to disable. For each app, you can also disable one or more of its app functions. Click the app’s expand
arrow to see the list of app functions.
For the Math menu, you can disable an entire category of functions (for example, Probability) or just a single
function or command (for example, Combinations). Click the expand arrow next to Mathematics to expand
the list of categories to get started.
When you are finished, save the configuration. You can then start and stop the configuration for the whole
class using the exam-mode editor of Connectivity Kit.
To edit and save an exam-mode configuration:
1.

Click the expand arrow beside the Exam Modes folder to expand the list of names of exam-mode
configurations.

2.

If you want to edit an existing configuration, double-click the name of the configuration and proceed to
step 5.

3.

To create a new configuration, right-click an existing configuration, and then select Copy. A copy will
appear with a default name. Type in a name for the new configuration, and then press Enter.

4.

Double-click the name of the new configuration.

5.

Use the computer keyboard and the mouse to create or edit the configuration in the exam-mode
configuration editor.

6.

Click the Save icon in the icon bar.

Proctor mode
Proctor mode is designed to facilitate starting and stopping an existing exam-mode configuration. To start
proctor mode, click the Proctor Mode icon. The proctor mode pane opens and displays a message that any HP
Prime calculator will be placed into exam mode immediately upon connection to HP Connectivity Kit.
To select an exam-mode configuration, click Open. To start proctor mode, click Start. The proctor mode pane
turns green when proctor mode is activated.

Proctor mode
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After proctor mode is activated, any HP Prime calculator that is connected to HP Connectivity Kit via USB or
wireless starts the selected exam-mode configuration. A list is displayed after each HP Prime calculator is
connected and the exam-mode configuration has successfully started. The calculator is then removed from
the list. When all calculators have successfully started the exam-mode configuration, click Stop to deactivate
Proctor mode, and then click the Proctor Mode icon to hide the proctor mode pane.
To open the proctor mode pane from the content pane, right-click an exam-mode configuration, and then
select Proctor Mode. The proctor mode pane opens with the selected exam-mode configuration open and
ready to activate as soon as students connect to HP Connectivity Kit.

Preparing a class poll
You can use Connectivity Kit to create a poll or quiz and save it to your computer for later distribution to the
class. Or you can create a quick one- or two-question poll to inform instructional decisions or enhance class
discussion.
To open or create a poll, click the Poll icon. Or, click the New Content icon and then select Poll.
Connectivity Kit has a dedicated editor for creating and editing polls. The poll editor in the content pane
allows you to do the following:
●

Name your poll

●

Give your poll a descriptive title

●

Enter general instructions for the entire poll

●

Choose the number of questions in the poll (select up to 10 questions)

●

Select a type for each question and create or edit each question

●

Save the poll

The poll editor has the following boxes to help you create a poll:
●

Title—Enter an optional title for your poll

●

Instructions—Enter an optional set of instructions for the entire poll

●

Questions—Choose 1 to 10 questions for your poll (each question appears in its own tab)

●

Immediate popup—Select this box if you want the poll to pop up automatically when it reaches the
student’s HP Prime calculator, or clear it if you prefer the poll to be accessed by pressing

and

selecting the poll by name
●

Can only send once—Select this box if you want the student to respond only once to the poll, or clear it
if you want students to be able to update their responses after they are first sent in

Each question tab has the following boxes:
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●

Question—Enter the question stem here

●

Can go back—Select this box if you want the student to be able to go back to this question after moving
to the next question, or clear it if you do not want the students to return to this question after answering
it and moving on

●

Type—Select an option to set the question’s response type. You can choose among the following
response types:
—

Multiple choice—Response is five types of fixed multiple-choice responses

—

Number—Response is a single real number
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—

Point—Response is an x-y pair

—

Expression—Response is an expression represented as a string

—

Text—Response is entered as text

—

Selection—Response is one or more options selected from a response set of 2 to 6 options

—

Choose—Response is a single option selected from a response set of 2 to 6 options

If you select Number, Point, or Expression, the question is complete at this point.
If you select a multiple choice response type, a second row of options is displayed, as shown in the previous
figure. Specify the particular response set by clicking an option in this second row. You can choose among the
following types of multiple-choice response sets:
●

ABCDE—A set of 2 to 5 response blanks which you fill in

●

Yes/No—Yes or No are the only two responses

●

True/False—True or False are the two responses

●

Likert Scale (3)

●

Likert Scale (5)

If you select a Yes/No or True/False response set, the Answer boxes are auto-populated with the relevant
options, and the question is complete at this point. If you select an ABCDE response set, enter the responses
into the Answer boxes, beginning with the first two (A and B). If you select one of the Likert Scale options, you
will see a third set of radio buttons from which to choose your response set:
●

Agreement—Level of agreement with the question’s statement

●

Confidence—Level of confidence

●

Occurrence—Always, sometimes, or never true questions

●

Custom—Likert Scale response set created by you

If you select Selection, you must define the number of responses in the Answer field and then enter each
response.
If you select Choose, you must define the number of responses in the Answer field and then enter each
response.
To prepare a poll or quiz in the content pane:
1.

To create a new poll, click the Poll icon.
– or –
Click the New Content icon and then select Poll.

2.

Delete the default name and enter your own, or press

to accept the default name.

3.

Use the computer keyboard and the mouse to edit the poll or quiz in the poll/quiz editor.

4.

Click the Save icon in the icon bar.

5.

Close the poll editor.

You can return to edit the poll at any time by double-clicking the name of the poll in the content pane.

Preparing a class poll
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Preparing a custom HP Prime app
You can use HP Prime apps to send examples and numerical data to students. HP Prime apps can be extended
via programs to help students explore mathematical concepts. These apps can be created or downloaded and
then distributed to students either one at a time via USB or all at once using the wireless classroom network.
HP recommends using HP Connectivity Kit to distribute apps to one or more HP Prime calculators.
Each default HP Prime app (Function, Advanced Graphing, Geometry, and so on) can be used as a template.
You can enter content such as definitions, expressions, text notes, programs, and data into this template.
Then, save the customized app with a new name.
For example, you can copy the numerical data known as Anscombe’s Quartet (in a spreadsheet format), and
then paste that data into the Statistics 2Var app on your virtual HP Prime calculator. Then, save the app with
the name Anscombe. You can now send Anscombe to your class via the wireless classroom network. Because
Anscombe is based on the Statistics 2Var app, it has the same functions as that app: you can create scatter
plots based on the data in the app, compute and draw lines of best fit, and so on.
In most cases, the changes you make to an app are made using either your physical or virtual HP Prime
calculator. You can also use the app editors in HP Connectivity Kit. However, there are a few changes that you
can make only by using the virtual HP Prime calculator and Connectivity Kit. See the following sections.

Adding a background
The Plot view of most HP Prime apps can contain an image as a background. This image is selected and
configured on page 3 of Plot Setup.
To add a background to your HP Prime app:
1.

In HP Connectivity Kit, open an HP Prime calculator in the calculator pane.

2.

On the selected HP Prime calculator, open Application Library.

3.

Right-click the app, and then select Add background.

4.

In the window that opens, select an image file.

5.

The image opens in a new window. A red rectangle outlines the part of the image that will be used as a
background. Move the rectangle to select a different part of the image. You can also zoom in or zoom
out.
TIP:

A preview is displayed in the bottom-right corner of the window.

6.

To select the image inside the red rectangle, click OK.

7.

In the calculator pane, double-click the app to open the app editor, and then click the Save icon. You can
see your image file in the Files tab.

8.

Save your changes, and then close the app editor.

The image is now the background in your app. To use your image, go to page 3 of Plot Setup. The image is
saved to the Files tab of your app editor. In HP Connectivity Kit, double-click the app and click the Files tab to
see your image file.

Adding an icon
By default, the icon for a new app is the same as the icon for the base app used as a template. You can use
another image as the icon for your new app.
To add a custom icon to an app:
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1.

In HP Connectivity Kit, open an HP Prime calculator in the calculator pane.

2.

On the selected HP Prime calculator, open Application Library.

3.

Right-click the app, and then select Add app icon.

4.

In the window that opens, select the image to be used as the app icon.

5.

In the calculator pane, double-click the app to open the app editor, and then click the Save icon. You can
see your icon file in the Files tab.

6.

Save your changes, and then close the app editor.

The image file is saved to the Files tab of your app editor with the name icon.png.

Adding a file
You might want to attach resource files to an app.
To add a file to an app:
1.

In HP Connectivity Kit, open an HP Prime calculator in the calculator pane.

2.

On the selected HP Prime calculator, open Application Library.

3.

Right-click the app, and then select Add file.

4.

In the window that opens, select the file.

5.

In the calculator pane, double-click the app to open the app editor, and then click the Save icon. You can
see your file in the Files tab.

6.

Save your changes, and then close the app editor.

Distributing an app to the class
You can distribute an app to other HP Prime calculators connected to HP Connectivity Kit via the USB cable or
using the wireless classroom network. Also, you can distribute an app from either an attached HP Prime
calculator or the content pane.
To distribute an app from an HP Prime calculator:
1.

In HP Connectivity Kit, open an HP Prime calculator in the calculator pane.

2.

On the selected HP Prime calculator, open Application Library.

3.

Right-click the app, and then select Send.

To distribute an app from the content pane:
1.

In the calculator pane, select the app and perform a drag-and-drop operation to save it to either the
content pane or a folder in the content pane.

2.

In the content pane, right-click the app, and then select Send to send it to all connected HP Prime
calculators.

Preparing a custom HP Prime app
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11 The Monitor window
Introduction
The Monitor window is designed for classroom use. Open this window to see thumbnail images of the displays
of all HP Prime calculators connected to Connectivity Kit. The thumbnail images refresh periodically so that
you can quickly monitor what your students are doing with their HP Prime calculators. You can use the
Monitor window to accomplish the following classroom tasks:
●

Monitor student progress

●

Capture and save a student display

●

Project a single student’s display for discussion purposes

●

Distribute HP Prime content

●

Distribute a poll and collect results

●

Display and project poll results for discussion purposes

●

Distribute poll results as lists

●

Start and stop an exam-mode configuration for testing purposes

Monitoring the class
To monitor the activity of all connected calculators, click the Window menu and select Monitor, or click the
Monitor icon on the right side of the icon bar. The Monitor window will open, showing the screens of all
connected calculators. To refresh the screens, right-click in the editor pane and select Refresh. To
automatically refresh the student displays every few seconds, right-click in the Monitor window and select
Automatic Refresh. You can deselect automatic refresh using the same steps.
To adjust the size of the calculator thumbnail images, right-click in the Monitor window and select Image
Size. A sub-menu opens from which you can choose small, medium, or large.

Capturing a student’s calculator display
You can capture and save the display of a student’s calculator from the Monitor window. Right-click the
thumbnail of the image you want to save, and then select Save As. A Save As dialog box opens. Navigate to
where you want to save the image, give it an appropriate name, select the file type (.bmp, .png, or .jpg), and
then click Save.
To copy the image the clipboard, right-click the thumbnail and select Copy to Clipboard. You can now paste
the image into a document.

Projecting a student’s calculator display
Any thumbnail of an HP Prime display can be selected for projection via a digital classroom projector. Rightclick the thumbnail, and then select Project. The student’s display will appear in its own window. You can
right-click in the Project window to select a size for the projected image, or you can perform a click-and-drag
operation on the bottom-right corner to resize the Project window. The projected image updates quickly so
that the student can operate their calculator and the class can follow in real time. While a student’s calculator
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display is being projected, the rest of the thumbnail images are frozen and will not update until the Project
window is closed.

Distributing HP Prime content
The Monitor window can be used to send HP Prime content to one or more student HP Prime calculators in the
class. To broadcast content to your class, follow these steps:
1.

In the content pane, click the expand arrow beside the folder containing the specific content item you
want to broadcast.

2.

After you see the specific content item you want to broadcast (a poll, an HP app, an exam-mode
configuration, and so on), drag it into the Monitor window.
NOTE: You can also right-click the item, and then select Send from the menu.

The content is sent immediately to each HP Prime calculator in the HP Classroom Network. If you want to send
content to only one HP Prime calculator, first select the thumbnail of that calculator in the Monitor window,
and then follow the previous procedure. To send content to a group of HP Prime calculators, press and hold
the Ctrl key on your computer keyboard while you select the calculators in the group. Then, follow the
previous procedure.

Accessing HP Prime content
After content is sent to one or more student HP Prime calculators, the students can access that content. If the
content is a list, matrix, note, or program, the students can access it by going to the proper catalog or library.
For example, if you send them a new HP app, they can find it by pressing

to go to their App library.

Taking a poll on an HP Prime calculator
What happens with poll content items depends on whether the Immediate Popup box was selected when
creating the poll. If Immediate Popup was selected, the HP Prime calculator displays the poll by opening the
Message Center. If Immediate Popup was not selected, the student receives no notification when a poll has
been delivered. Instead, the student must access the poll by pressing

to open the menu, and then

selecting the poll by its title from the list. The poll will then open in the Message Center.
After the Message Center opens with a poll, the student navigates and responds to the poll using the touch
menu buttons at the bottom of the HP Prime display. The touch menu buttons available for use in a poll are as
follows:
●

—Opens an edit line for entering a value or calculation as a response to a question

●

—Selects or clears a check mark for an option in a multiple choice question

●

—Sends the poll responses to Connectivity Kit

●

—Navigates from page to page in the poll

The exact appearance of the last double menu button depends on how many questions the poll contains as
well as whether the Can go back option for the current question was selected when the poll was written.

Distributing HP Prime content
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The student can leave the poll to use the calculator and then return to answer the question. For example, the
student can press

to go to the Home view and make a calculation. Then, the student can press

and select the poll by title from the list to return and answer the question.
The student can view a poll after it has been submitted by pressing

to open the menu, and selecting

the poll by its title. If the Can only send once option was selected when the poll was created, the students
cannot edit their responses and resubmit them after the poll has been submitted the first time.
The calculator can store only one poll at a time. When a new poll is received from Connectivity Kit, the
previous one is deleted.

Receiving responses and analyzing results
As the students respond to a poll, you can view the aggregated responses. When a poll is created and saved, a
Results object with the same name is created in the content pane. For example, a poll named funnypoll.hppoll
has a Results file named funnypoll.hpresult. To view the current state of the results of your poll, click the
Results icon or double-click the name of your Results file in the content pane. The Results window for your
poll opens.
The Results window has one tab for each question in the poll. In addition, an All tab aggregates the responses
for all of the questions in the poll in an app that can be distributed to the class. The graphical representation
on each tab varies depending on the response type.
Depending on the response type, you might be able to choose from a range of different graphical
representations. A drop-down menu at the bottom-right corner of the question tab allows you to select an
appropriate graphical representation of the aggregated poll results for that question. Each tab also has a
table of all student responses to the question.
Note that a student’s response is included in the aggregation only if they have submitted it. Note also that if
you are viewing the results for a question, the results automatically update as more students submit their
responses to the question.
You can use poll results to make instructional decisions during a lesson or you can project the results to the
class to enhance classroom discussion.

Sending results to the class
Just as you can broadcast HP Prime content to the class, you can also return poll results to the class.
To open a poll results file, double-click the file. The results from each question are displayed in separate tabs,
with an All tab containing the aggregate results for the poll. Each tab contains a Send to class button. To send
results for an individual question to the class, select Send to class. The results for each question are stored in
the version of the Statistics 1Var app with the same name as the poll, followed by _1 for the first question, _2
for the second question, and so on.
The All tab contains the aggregate results for the entire poll. There is a check box next to each question.
To send aggregate results to the class:
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1.

Select a question to include its results.

2.

In the Type field, select either Statistics 1Var or Statistics 2Var. This creates a version of the Statistics
1Var or Statistics 2Var app with the same name as the poll, by default. You can enter a different name.
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3.

Preview the results when they appear in the preview pane.

4.

Click Send to class.

Start and stop exam mode
An exam-mode configuration allows you to temporarily disable features and commands on your students’ HP
Prime calculators for testing purposes. You can use Connectivity Kit to start or stop an exam-mode
configuration on one or more HP Prime calculators. For information on how to create or edit an exam-mode
configuration, see Preparing exam-mode configurations on page 26.
To start an existing exam-mode configuration for your class, follow these steps:
1.

Open the Monitor window.

2.

Double-click the specific exam-mode configuration you want to use.

3.

The exam-mode configuration editor opens with your selected exam-mode configuration. Take a
moment to verify that the time duration, password, memory option, and option to blink LED lights are
set correctly.

4.

Click the Start button in the editor.

If you chose Blink LED in the configuration, all the HP Prime calculators in your class will have the same set of
LED lights on at the same time. The configuration will change every 5 to 10 seconds but will always be
identical for the same exam-mode configuration. The students will see the title bar in their display change
from blue to orange to indicate to them that an exam-mode configuration is active.
To stop exam mode, click the Stop button in the editor or tell the students the password to enter on the third
page of Home Settings.
To use proctor mode to activate exam mode:
1.

In the content pane, right-click an exam-mode configuration, and then select Proctor Mode.

2.

The proctor mode pane opens with the selected exam-mode configuration ready to activate when
students connect to HP Connectivity Kit. Click Start to activate proctor mode.

The proctor mode pane turns green when proctor mode is activated.
After proctor mode is activated, any HP Prime calculator that is connected to HP Connectivity Kit via USB or
wireless starts the selected exam-mode configuration. A list is displayed after each HP Prime calculator is
connected and the exam-mode configuration has successfully started. The calculator is then removed from
the list. When all calculators have successfully started the exam-mode configuration, click Stop to deactivate
Proctor mode, and then click the Proctor Mode icon to hide the proctor mode pane.

Sending an exam-mode configuration
You can send an exam-mode configuration to a set of HP Prime calculators without activating it. It can be
activated later on each calculator.
To send an exam-mode configuration without activating it, select the exam-mode configuration from the
content pane and then follow the instructions in Distributing HP Prime content on page 33.
You can also send an exam-mode configuration from one calculator to another. Select the exam-mode
configuration on one calculator and drag it to the other calculator.
In either case, the exam-mode configuration can then be activated on the HP Prime calculator by going to the
third page of Home Settings and tapping Start.

Start and stop exam mode
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12 The Messages window
Introduction
The Messages window is also designed for classroom use. Open this window to send a message to one
student, a group of students, or the entire class. Students can reply to your message individually or send you
a message of their own. In addition, a student can raise a flag for help. Note that a student cannot send a
message to another student or receive a message from another student.

Sending messages
To send a message, follow these steps:
1.

Open both the Monitor window and the Messages window.

2.

Select recipients for your message in the Monitor window.
If you want to send a message to the entire class, be sure that none of the thumbnail images are
selected in the Monitor window. If you want to send a message to a single HP Prime calculator, click its
thumbnail image in the Monitor window to select it; you can add more HP Prime calculators by holding
down the Ctrl key on your computer keyboard as you click additional thumbnail images.

3.

Enter your message in the entry box at the bottom of the Messages window.

4.

Click the Send to class button when your message is complete.

HP Prime Message Center
On the student’s HP Prime calculator, the message appears in the Message Center. When you send a message
to the students, the Message Center will open automatically and display your message to the student. A
student can always open the Message Center manually by pressing

and selecting Messages.

The Message Center has three menu buttons:
●

Reply—The student can tap this button to open an edit line to enter a reply. The student will see Cancel
and Send buttons. They can tap Send to send their reply to you.

●

Help—The student can tap this button to raise a help flag next to their HP Prime calculator name on
your computer.

●

OK—The student can tap this button to exit the Message Center.

Sending a reply or message from an HP Prime calculator
A student can reply to your message following these steps:
1.
2.
3.
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In the Message Center, they tap Reply.
Then, they press

to lock alpha mode on and enter their message.

They tap Send to send their message or Cancel to return to the Message Center without sending their
message.
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The student’s message will appear in the Message window history, labeled with their HP Prime calculator
name. A student can send you an unsolicited message by pressing

and selecting Messages, and then

following the previous procedure.

Sending a quick message
You can send a quick message without using the Messages window. The steps are as follows:
1.

In the Monitor window, select the thumbnail images of the HP Prime calculators to which you want to
send the message.

2.

Right-click one of those thumbnail images and select Send Message.

3.

A Message box will appear. Enter your message in the entry line and tap the Send button.

Using this method, your message does not appear in the Messages window history.

Raising and clearing help flags
A student can send a request for help from a calculator connected to Connectivity Kit by pressing

,

selecting Messages, and then tapping the Help menu button. When a student asks for help, a flag appears
beside the thumbnail image of their calculator in the Monitor window. The help flag appears as a question
mark in a blue circle at the top left of the thumbnail image.
You can clear the flag by right-clicking the thumbnail image and selecting Reset Help. If you want to reset
multiple student help flags, hold down the Ctrl key on your computer keyboard while you select each student.
After you have selected all the students you want, right-click one of their thumbnail images and select Reset
Help.

Sending a quick message
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